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AutoCAD 2026 Tutorial: 3D Modeling
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Chapter 3
UCS, Viewports and Wireframe Modeling

=Y

S

Ohjectives

¢ Understand the Use of UCS on More
Complex Designs

¢ Display and Orient 3D Views

¢ Apply and Expand the Basic Wireframe
Construction Techniques

¢ Use Additional Tools to Assist the
Creation of 3D Wireframe Models

¢ Use the Named Views Option
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Introduction

In the previous chapter, we examined some of the basic techniques to create 3D
wireframe models. Again, a wireframe model is a skeletal description of a 3D object.
There are no surfaces in a wireframe model; it consists only of points, lines, and curves
that describe the edges of the object.

In this chapter, we will further discuss the techniques and wireframe modeling tools
available in AutoCAD. Instead of creating the corners and edges of wireframe models by
entering the precise 3D coordinates, the use of construction lines and referencing
techniques are illustrated. The construction of edges in 3D space can be simplified by
using the AutoCAD User Coordinate System. We will also use the multiple viewports
option, which is available in most CAD systems, to aid the construction of 3D wireframe
models.

It is important to point out that most of the construction tools used in creating 2D designs,

such as Object Snap and Polar Tracking, as well as the Copy, Mirror, and Array
commands, are also applicable to the constructions of 3D wireframe models.

The V-Block Design
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Starting Up AutoCAD 2026

1. Select the AutoCAD 2026 option on the Program menu or select the AutoCAD
2026 icon on the Desktop.

All

AutoCAD 2026 - English

i Attach Digital Signatures

ﬂ AutoCAD 2026 - English

s

|~_ij Batch Standards Checker

Export AutoCAD 2026 Settings

Import AutoCAD 2026 Settings

2. In the Startup window, select Start from Scratch.

3. In the Default Settings section, pick Imperial (feet and inches) as the drawing
units.

| 4. Pick OK in the Startup dialog box to accept the selected settings.

3D Modeling Workspace

{5%3D Basics -5
Drafting & Annotation vodify| 1. Click on the workspaces list in the Quick_Access
B — toolbar and choose to use the 3D Modeling

workspace as shown.

3D Modeling N

L4

2. On your own, switch on the Menu Bar.
| Save Current| 35 pa S Y

Workspace » Notice the different 3D modeling toolbars

available in the Ribbon toolbar area as shown.

S‘ Press F1 for more help

Customize.. T

B CoHBEL S G © [Soveng - e Dravinglvg imearmopae @ Bpnagiin - B & | @@ - 0 X
Home Soid Suface Mesh Visudlze Pawmetic Inset Amnotate View Menage Output Addiins Colcborte ExpressTooks FesturedApps [
g g{ @ @PEED- L - hhE G C@ 16 18 tn, 18 19 [0 Wicrme ~ @ ﬂ @ [BT =
g 0 L. NS () (e o G- te 12 EUncaved View ~ b =
b i B 5o @ @SB V06 @0 D seton 57 15 1 T8 T, U Vew Cilling| NoFiter Move | Loyers | Groups | View
g g et @ H G- OO G- S ARS8 Pane - @Wod v - ° Gizmo ™
Mesh s Solid Editing + Draw ~ Modify ~ Section * u Coordinates Hl View *

Modeling ~ Selection
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Layers Setup
1. In the Menu Bar, select [Tools] 2 [Toolbars] > [AutoCAD] - [Layers].

Tools Draw Dimension Modify Window Help  Parame 3D Navigation
Workspaces > Fe Output  Colla Aray Edit
ﬁ Baleites ’ 4 te . 1 Array_Toolbar
M loelbar > AutoCAD & CAD Standards
Command Line Ctrl+9 Section = . Camera Adjustment
i Clean Screen Ctrl+0 plang ’ Dimension
" A% Spelling ection ~ ¥ Co Dimensional Constraints
NE Quick Select... Draw
Draw Order > Draw Order
Isolate > Draw Order, Annotation to Front
Inquiry > Find Text
£ Update Fields Geometric Constraint
N Group
Cn Block Editor gty
Xref and Block In-place Editing > T
2 ata Extraction...
B Data Bxtracti pr—
Data Links

2. Click Layer Properties Manager in the
(-] Layer Properties Manager Layers toolbar.

7

« In AutoCAD, we always construct entities on a layer. It may be the default layer or a
layer that we create. Each layer has associated properties such as the visibility setting,
color, linetype, lineweight, and plot style.

ﬁ == = 3. Click on the New Layer button. Notice a layer is

automatically added to the list of layers.

New Layer (Alt+N)

4. Create two new layers with the following settings:

Layer Color Linetype Lineweight
Construction Grey Continuous  Default
Object Cyan Continuous  0.30mm

5. Highlight the layer Construction in the list of layers.

6. Click on the Set Current icon to set layer Construction
as the Current Layer.

xl,\\, 7. Click on the Close button to accept the settings and

Al e SEsl exit the Layer Properties Manager dialog box.
Ea=lE .

Close i 8. Inthe Status Bar area, turn ON the Grid Display, Polar

| Fers & Tracking, Object Snap, Object Snap Tracking, Dynamic

=-£ Al Input and Lineweight options.
-3 All Used
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Create the Rectangular Base of the Design

We will first use construction geometry to define the outer edges of the design.

1£f| @9 1 uf’ M Construction X 1. Inthe Layer Control box,
confirm that layer
Construction is set as the
Current Layer.

bols Draw Dimension M

2. Select the Rectangle icon in the Draw toolbar. In the
command prompt area, the message “Specify first corner
point or [Chamfer/Elevation/Fillet/ Thickness/ Width]:”
is displayed.

rametric  Insert  Annotate
ARl = gl | BN
dieFaE CRal *

Place the first corner point of the rectangle near the
lower left corner of the screen. Do not be overly
concerned about the actual coordinates of the location;
the drawing space is as big as you can imagine.

Creates a rectangular

4. We will create a 3" x 2" rectangle by entering the coordinates of the second corner
using the relative coordinates input method.
Specify other corner point or [Dimension]: @3,2 [ENTER].

T_ﬂ; .ED Wireframe

ts, |Unsaved‘.|"ie1.n.'

5. Inthe View panel, select:

«| ([ Top [Unsaved View] = [SE Isometric]
’ D Let e Notice the orientation of the sketched 2D rectangle in
. (E Right relation to the displayed AutoCAD user coordinate
@) Front system. By default, the 2D sketch-plane is aligned to
MBack the XY plane of the world coordinate system.
\"J‘B SW Isornetric
K‘% SE Isomgtric |

€3 NE Isarrjl'[ESEI -
@ MW Iso SOMELric

Yiew Manager...
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Create a Wireframe Box

Next, we will use the Copy command to define the 3D boundary of the design.

mension Maodify  Window

1. Click on the Copy Object icon in the Modify toolbar.

Annotate  View Manage
de &4 B
B ®C [

2. In the command prompt area, the message “Select
objects:” is displayed. Pick any edge of the sketched
rectangle.

3. Inside the graphics window, right-click once to accept
the selection.

4. In the command prompt area, the message “Specify base point or displacement, or
[Multiple]:” is displayed. Pick any corner of the sketched rectangle as a base point to
create the copy.

5. In the command prompt area, the message “Specify second point of displacement or
<use first point as displacement>:" is displayed.
Enter @0,0,2.25 [ENTER].

» Note that the three values represent the distance measured in the X, Y and Z
directions relative to the current UCS.

Use the Zoom All command, in the View Display toolbar, to
adjust the display.

On your own, use the Line command to create the four lines
connecting the four-corners of the two rectangles as shown.

v | Zoom Extents

Zoom Window

Zoom Previous

Zoom Realtime

Zoom All % .

bls Draw Dimension Mo

bmetric  Insert  Annotate
DA T AP

™~ /I\O B & O
G C

Dr
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Using the View and UCS Toolbars
1. In the Menu Bar, select [Tools] 2 [Toolbars] 2> [AutoCAD].

Tools Draw  Dimension Modify Window  Help  Param

Workspaces >
Palettes b

! | Command Line Ctrl+9

Clean Screen Ctrl+0

AN —I[)

2. Select View, with the left-mouse-button, to display the View
toolbar on the screen.

Viewpo
Visual Styles

. Move the cursor to the Standard toolbar area and right-click
on any icon of the Standard toolbar to display a list of toolbar
menu groups.

Select UCS I, with the left-mouse-button, to display the
UCSII toolbar on the screen.

» The options available in UCS /I toolbar allow us to quickly align the UCS to the
preset standard 2D views.

T, 1]

j 5. Note that the current UCS is aligned to the
World Coordinate System. Select Front in
the UCS II toolbar as shown.

|~ JISE Tsometric]|2D Wireframe]

» Note that the UCS has been
adjusted and it is now aligned
parallel to the front view of the
wireframe box as shown in the
figure.
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Create Construction Lines in the Front View

Is Draw Dimension %]

1. Select the Line command icon in the Draw toolbar. In
L the command prompt area, the message “_line Specify
DA T AP first point.” is displayed.

NMAO B ®C

pmetric  Insert  Annotate

2. Inside the graphics window, hold down the [SHIFT]
key and right-click once to bring up the Object Snap
shortcut menu.

Mid &tween 2 Points

Point Filters » .. .
Select the From option in the pop-up window.
30 Osnap

Pick the lower right corner of the bottom horizontal
line in the front view as the base point.

In the command prompt area, the message “Specify
next point or [Undo]:” is displayed. Enter @0,0.75
[ENTER].

6. We will set up the Polar Tracking option to assist the
creation of the next corner. Right-click once on the
POLAR Tracking option located at the bottom of the
graphics window.

Restrict cursor to specified |
Polar Tracking (F10)
= b (G Y - [

¥, I, 1T, 20

| TraclcilﬁSettings... |
Lz’
=l b (@]~ W - (2T

a Drafting Settings

7. In the option menu, select Settings by clicking once
with the left-mouse-button.

8. Inthe Drafting Settings dialog box, set the Polar

Snap and Grid Polar Tracking  Ohject -
Increment Angle setting to 30 degrees.

B Folar Tracking On (F10)

Palar Angle Settings
Increment angle:

'-sh-f tional angles

Drafting Setti
8 orafting settings 9. Click on the Object Snap tab to switch to the

Snap and Grd Polar Tracking Chbiject.Snap Object Snap option settings.
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ﬂ Drafting Settings

Snap and Grid  Polar Tracking Object Snap 3D Object Snap  Dynamic Input .
10. Confirm that the Intersection and

Object Snap On (F3) Object Snap Tracking On (F1 . . .
8 Oyect nep On 3 e Extension options are switched ON as

Object Snap modes h

O @ Endpoint - [ Exension Sell shown.

Ay [ Midpoint 4 [ Insertion

o B Center b [ Perpendicular .

11. Click on the OK button to accept the
3 [0 Geometric Center T [ Tangent .
settings.

& [ Node = [ Nearest

o [ Quadrant B [ Apparent intersection

% (@ Intersection £ [ Parallel

o To track from an Osnap point, pause over the point while in a
command. A tracking vector appears when you move the cursor.
stop tracking, pause over the point again.

. In the command prompt area, the
message “Specify next point or [Undo]:”
is displayed. Using the Polar Tracking
option (30 degrees increment), create a
line as shown in the figure.

13. Move the cursor near the left vertical
edge of the front view and create the
second line perpendicular to the last
line we created.

14. Inside the graphics window, right-
click to activate the option menu and
select Enter with the left-mouse-
button to end the Line command.
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Copy Objects in the Negative Z Direction

mension  Modify  Window

1. Click on the Copy Object icon in the Modify toolbar.

Annotate  View Manage

e & ¢ Y

2. In the command prompt area, the message “Select
objects:” is displayed. Pick the two edges we just
created.

3. Inside the graphics window, right-click once to accept
the selection.

4. In the command prompt area, the message “Specify base point or displacement, or
[Multiple]:” is displayed. Pick any corner of the wireframe model to use as a base
point to create the copy.

5. In the command prompt area, the message “Specify second point of displacement or
<use first point as displacement>:" is displayed.

Enter @0,0,-2.0 [ENTER].

6. Note that the negative value represents the distance measured in the negative Z
direction relative to the current UCS.

7. On your own, create three lines to connect the corners of the two sets of lines we just
created, as shown below.

|—1I5E Isometric ]| 2D Wireframe]
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Create an Inclined Line at the Base of the Model

Select Top in the UCS II toolbar as shown.

Is Draw Dimension M

2. Select the Line command icon in the Draw toolbar. In

pse. leer | RnmRe the command prompt area, the message “_line Specify
DA iR first point.” is displayed.
~J =
: & ©-6®C0 3. Inside the graphics window, hold down the [SHIFT] key

@ and right-click once to bring up the Object Snap

shortcut menu.

Line

—  Temporary track point

Mid Between 2 Points

o 4. Select the From option in the pop-up window.
Point Filters >

3D Osnap

. Pick the lower right corner of the bottom horizontal line
as the base point as shown in the figure.

. We will place the first point above the selected corner.
Enter @0,0.75 [ENTER].

. In the command prompt area, the message “Specify next
point or [Undo].” is displayed. Using the Polar Tracking
option (30 degrees increment), create a line as shown in
the figure.

[-1ISE Isometric || 2D Wireframe]

8. Inside the graphics window, right-
click to activate the option menu
and select Enter with the left-
mouse-button to end the Line
command.
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» On your own, use the Copy and Line commands to create additional edges so that the
wireframe model appears as shown below.

[—1I5E sometric ]| 2D Wireframe]

1. On the Object Properties toolbar, choose
the Layer Control box with the left-mouse-
button.

2. Move the cursor over the name of layer
Object; the tool tip “Object” appears.

3. Left-click once on the layer name; now layer Object is set as the Current Layer.

pls Draw Dimension Ma
pmetric  Insert  Annotate
e 4. Select the Line command icon in the Draw toolbar. In
DA AP @ 1 .
i the command prompt area, the message “ line Specify
B N -6 &C first point.” is displayed.
@ -

Line
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5. Pick the lower left corner of the bottom of the wireframe model as the starting point
and create the four line segments as shown.

[—JISE Isometric ][2D Wireframe]

| Fourth point

Fifth point \

Third point

First point .

Second point |-

¢ Note that even though the UCS is aligned to the base plane of the model, the Object
Snap option enables us to select points on the front plane of the model.

» On your own, create three additional lines representing the edges of the inclined face
of the design as shown.

[—1ISE Isometric ][ 2D Wireframe]
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Multiple Viewports

View Insert Format Tools Draw Dimension Modify  Wind

1. In the Menu Bar, select:

bt " Redraw Jsert  Annotate  View  Man
B Regen . o% I -
L5 regenn - g: 'é’ ° Ifi | [view] > [Viewports] >
Zoom b 4 AQl ©®- [4 VleWportS]
Pan >
@) steeringWheels f il » AutoCAD allows us to display
| ShowMotion = different VIEWS of the model
- g:l:;a Z &= simultaneously. Only one
Y Walkand Fly 5 viewport is activated at one
e p—_— time. The viewport with the
Viewports B E2 Named viewports dgrker border is the active
BR Named Views. Et NewViewports. yleyvport. Mqve the cursor
3D Views > B inside each viewport and
(@] Create Camera AP notice the different cursor-
Show Annotative Objects > 3 Viewports dlsplay inside the active
% Hide - 4 Viewgorts viewport.
. “7. Polygonal Viewport

Y- FEET LR

Top

2. Activate the top left viewport by left-clicking once
inside the viewport.

Sets the view point to top
= VIEW

4. On your own, repeat the above steps and use the Realtime Zoom command to set
and adjust the displays of the viewports as shown below.

3. Select the Top view in the View toolbar to change
the display of the viewport.

I [+1ISE Isométric J|20 Wireframe]

/ 25*23'

» Note that the displayed UCS icons at the lower left corner of each viewport
correspond to the orientation of the wireframe model in each viewport.
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Use the Mirror Command

1. Activate the top left viewport by left-clicking once inside the viewport.

2. Pre-select all the objects in the active viewport by using a selection window.

[+1TopH2D Wireframe] -

v

First corner

Second corner

J

Subobject Selection Fil
Quick Select...

Quick&lc

(@ Include in new selection set

() Exclude from new selection set

[JAppend to current selection set

| OK | | Cancel | |

A Quick Select X
Apply to |Cunentselec1ion V|
Objecttype |Mu|lip|e v|
Properties: [cglor 5
Linetype
Linetype scale 6
Plot style :
Lineweight
Transparency
Hyperlink
Operator |=Equals v|
Value |§0bject v| 8
How to apply:

3. Inside the active viewport, right-click to bring up the pop-
up option menu and select the Quick Select option.

In the Quick Select dialog box, select
Layer from the Properties list.

Set the Value box to Object.
In the How to apply section, confirm the

Include in new selection set option
is selected.

Switch OFF the Append to current
selection set.

Click on the OK button to accept the
settings.

AutoCAD will now filter out objects
that are not on layer Object.
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Annotate  View Manage Output
nEE DY of

€En N =
E.—_’ O =\ | Section
i A E € 8 - Plane

Section = ¥

9. Click on the Mirror icon in the Modify toolbar.

10. Inside the graphics window, hold down the [SHIFT]
key and right-click once to bring up the Object
Snap shortcut menu.

R & E%A&
TE Ny =

( Apparent Intersect

12. Inside the active viewport, click on the left vertical line
of the wireframe model. With the Midpoint snap option,
the midpoint of the line is selected.

13. Move the cursor toward the
right vertical line in the active
viewport; left-click once when
the Intersection symbol is
displayed as shown.

14. In the command prompt area, the
message “Delete Source Objects?
[Yes/No] <N>:"is displayed.
Inside the graphics window, right-
click once to bring up the option
menu and select No to keep both
sets of objects.
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Turn Off the Construction Lines

1. On the Object Properties toolbar, choose the Layer Control box with the left-mouse-
button.

: £ 2 & [ f' W Object 2. Move the cursor over the light-bulb icon for
layer Construction, left-click once, and notice the
icon color is changed to a gray tone color,
representing the layer (layer Construction) is

Turn a layer On or Off turned OFF.

View Insert Format  Tools Draw  Dimension Modify

3. In the Menu Bar, select:

1./ Redraw Jsert  Annotate  View
[ Regen T AP B [View] = [Viewports] >
T8 Regen Al D - ¢ M [1 Viewport]

Zoom Z b - | # A m = '
Pan e Viewports can also be used as a

: E Modify ~
g z;ee":qgfhee's way of checking the integrity of
L ononen e the constructed 3D models. Feel
! Orbit > kB p ch Ltinl
E  Camem s | ree to sw1j[c to mu tlp.e
[ Walkand Fly > viewports in the following
Clean Screen Cirl+0 \ sections of this tutorial.
Viewports > Iy Named Viewports..
i el sk 4. On your own, create the

m New Viewports...
> 1Viquport
2 Viewports
3 Viewports

additional object lines
connecting the two sets of objects
as shown below.

3D Views
@ Create Camera

Show Annotative Objects
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» The V-cut feature of the
design is the last feature, and
perhaps the most difficult one,
to create in the CAD system.
Based on your knowledge of
modeling with AutoCAD,
how would you create this
feature? What are the more
difficult aspects of creating
this feature?

Create a New UCS

Besides using the preset UCS planes, AutoCAD also allows us to change our viewpoint

and create new UCS planes. We will create a UCS plane aligning to the inclined plane of
the design.

Display Image > I I
e e e 1. Inthe Menu Bar, select:
ew World
- o et [Tools] > [New UCS] >
& Named UCS.. t  Previous [3 Point]
& Geographic Location.. t% Face
CAD Standards > |19, Object ¢ Note that other options are also
Wizards > |13 view available to aid in the creation
jﬁ:, Drafting Settings.. T’» Origin of new UCS planes.
[E[" Group 12,z Axds Vector
.
gf Ungroup TE. 3&““
Tablet > o o

2. In the command prompt area, the message
“Specify New Origin point <0,0,0>:" is
displayed. Pick the lower-left corner of the
inclined plane as shown.

Intersection
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|

Intergection

4,

In the command prompt area, the
message “Specify point on positive
portion of X-axis:” is displayed. Pick the
top left corner of the inclined plane as
shown.

In the command prompt area, the message
“Specify point on positive portion of X-axis:”
is displayed. Pick the lower right corner of
the inclined plane as shown.

>

N

> UCS Icon > fa, on
ViewCube > | Origin
Attribute Display > Pro[ﬁrties_
(o) Cameras N

5. In the Menu Bar, select

[View] - [Display] >

Lights

<,
E MNavigation Bar
&

Text Window Ctrl+F2
——

[UCS Icon] > [Properties]

B ucs icon

6. Inthe UCS Icon window, switch the UCS icon style to o P

2D as shown.

LICS icon style

O3 Line width:

7. Click on the OK button to
accept the settings.
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Create a New Named View

Besides using the preset views, AutoCAD also allows us to change our viewpoint and
create new views, which can be saved and restored by name for convenient access. We
will create a new view aligned to the new UCS plane we just created.

1. Inthe Menu Bar, select

[View] - [3D Views] - [Plan View] 2 [Current UCS].

@ Create Camera

Show Annotative Objects
Hide

Visual Styles

Render

Viewports
% Named Views.. /\
3D Views

Viewpoint Presets... |

Viewpoint

Plan View > Current UCS
T World UCS
Bottom Named UCS

e The graphics window is now adjusted to display the current UCS plane.

REoed|>

Click on the Named Views
icon in the View toolbar.

Named Views...

*
N /]
3.
ﬂ Mew View / Shot Properties
View name: Auxiliary
View category: <Monex
View type: sl
Boundary
© current display +[}

() Define window

In the View dialog box, click on the New button to
create a new named view.

- Set Current

[ he ]
Lag”

Update Layers

4. Inthe New View dialog box, enter

Auxiliary as the new View name and
confirm the Current display option. In
the View Properties list, set the Save
layer Snapshot with view option to
ON and the UCS option as Unnamed.

5. Click on the OK button to accept the

settings and create the named view.
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6. In the View dialog box, the new named view (Auxiliary) is added to the Named Views
list. Note that we can always switch to this view by using the Set Current option.

ﬂ View Manager X

Current View: Current

Views
(f\ Current General - Set Current
: Model Views Name Auxiliary N
B Auxili New...
w Auxiliary Category <MNone>
; Layout Views ucs Unnamed Update Layers

:D: Preset Views
Layer snaps... Yes Edit Boundaries...

Annotation... 11
Visual Style | 2D Wireframe

Background... <Mone>

Delete

Live Section  <MNone>

Animation 4
View type Still

OK Cancel Apply Help

7. Click on the OK button to accept the settings.

1 .
- ‘ A Ped i @ ‘ @@E}@ & ‘@‘ EJ—| 8. 1In the View toolbar, select SE

Isometric View.

SE Isometric
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Create the V-Cut Feature on the Inclined Plane

1. On your own, create two lines that are 0.2"” away from the top corners of the model,
which are also rotated 45 degrees relative to the top edge of the model.

6. Second Point |

-

5. Base Point

<

mension  Modify  Window

Annotate  View Manage

e &4 Y- g

hl :‘.@,} (:.

4ARId™

i Bl Copies objects
Modify

Click on the Copy Object icon in the Modify toolbar.

In the command prompt area, the message “Select
objects:” is displayed. Pick the two inclined lines we
just created.

Inside the graphics window, right-click once to accept
the selections.

5. In the command prompt area, the message “Specify base point or displacement, or
[Multiple]:” is displayed. Pick the top left corner as the base point to create the

copy.

6. In the command prompt area, the message
“Specify second point of displacement or
<use first point as displacement>:" is
displayed. Pick the corresponding corner
on the backside of the model as shown in
the above figure.

7. On your own, create additional lines to
define the edges of the V-cut and use the
Trim command to complete the model as
shown.
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8. Click on the Front View icon in the View
toolbar.

> Note that the V-cut we
created, using the Copy
command, does not represent
a cut that passes through the
entire block.

Extend the Cut and GRIP Editing

mension  Modify  Window  Help
Annotate  View Manage Outp

A BEE o
L ®C DU L
7 A E‘ E! e

Modify : ! _"{

1. Select the Extend command icon in the Modify
toolbar.

en-d ‘ - u
2. The message “Select object to Extend or [Project/ Edge/ Undo]:” is displayed in the
command prompt area. Pick the bottom edge of the V-cut to extend.

Boundary

Extend
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3. Inside the graphics window, right-click to activate the option menu and select Enter
with the left-mouse-button to end the Extend command.

RO DE O DM |f§@ @ € |@| 4. Click on the SW Isometric View

icon to reset the display to the preset
SW Isometric isometric view.

. Pre-select the top edge of the V-block as shown.

Left-click once on the lower right grip point on the
selected line.

Selecting the grip points located at the end of the line or
arc allows us to STRETCH the selected line.

7. Move the cursor toward and select the lower corner of
the V-cut as shown.

» On your own, repeat the above steps and use the grip
editing options and complete the wireframe model as
shown below.
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Review Questions:

1.

List and describe three different types of 3D computer geometric modeling software
available today.

. What is a Named View?

. What is the difference between Stretch and Extend?

List and describe the methods available in AutoCAD to create a new UCS plane.
What is the difference between Copy and Mirror in AutoCAD?

Identify and describe the following commands:

a)

I
b)
C)

-
d)

Ak
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Exercises: (Unless otherwise specified, dimensions are in inches.)

l.

6.50

—1.50

3,50

1.00—
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275

1.00
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